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Introduction 

Overview  
The WinSen Remote Site Control Module (RSCM) software program is specifically designed to 
manage distant, unattended facilities.  It is used to control, normally via modem, one or more SSC 
standalone keypads.  The SSC standalone keypad is self contained, e.g., it has all the user codes, time 
zone assignments, and locked out statuses stored in its local database.  WinSen RSCM is used to 
update the remote keypad database. 

The WinSen RSCM software runs under the Windows 95, Windows 98, Windows NT, Windows 
2000, and Windows XP operating systems.  

Daily Operations 
If you have our WinSen Property Manager or WinSen Electronic Manager software, operation of the 
WinSen RSCM system on a daily basis is quite simple:  

• You perform your moveins, moveouts, transfers, overlocks, readmits, payments, etc., in WinSen 
Property Manager or Electronic Manager.  The activity is written to your hard drive as it occurs.  

• To update the remote system (which has a self-contained database of the users) you will select the 
“Start Automatic Communications” option from the WinSen RSCM File menu.  RSCM will 
then dial the remote site(s) via modem and transmit the entire day’s activity to the remote 
keypads all at once.  It will also transfer the keypad activity that has occurred today to the home 
office computer for reporting purposes.  You may also elect to have the Automatic 
Communications function begin automatically at a pre-defined time each day, for example after 
5 P.M. when long distance rates go down.  This could be a money saver if it is a long distance call 
to your remote facility.  

• The program can also be setup to update the remote system in “real-time”. In this case, the remote 
keypads are updated as soon as any transaction is done in Winsen Property Manager that affects 
the remote site.  

If you do not have WinSen Property Manager or Electronic Manager software, you will use WinSen 
RSCM to update the remote standalone keypads with the “Manual Communications” options which 
are explained in detail in “Manual Communications” beginning on page 18. 

• In either case, you can print activity reports detailing exactly who has entered the remote facility 
in a given time period, events that have occurred, etc.  The reporting functions of RSCM will be 
explained in following sections.  
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Manual Conventions 
Example Keystrokes 
When a key needs to be pressed, this manual will enclose the description of the key with angle 
brackets as shown: 
 
 <  >  

The brackets are for clarifying what key is to be pressed and are not part of the keystroke.  For 
example, when you see something like: 

 Press the <Enter> key to continue 

This would mean to press the Enter key.  The angle brackets are only for clarification. 

Combination Keys 
When two keys need to be pressed at once, it will be shown as 

 <Ctrl+Esc> 

The above example would indicate pressing the Ctrl and the Esc key simultaneously.  This would 
normally be done by holding the first key, then pressing the second one.  Another example: pressing 
Alt and F1 at the same time would be shown as <Alt+F1>. 

Example Commands  
When a command needs to be typed, it will be shown in bold.  For example, when you see something 
like:  

 Type A:SETUP then press <Enter> 

This would mean to type in A:SETUP followed by pressing the Enter key.  

Example Screens  
The screen shots in this manual were taken on a computer running Windows XP.  If your computer is 
running a different version of  Windows, your screens may look slightly different. 

Selecting Items from the Menus 
To describe selecting a menu item, menu items will be separated with a pipe symbol, “|”.  For 
example, to denote selecting “Manual Communications” from the File Menu, it will be shown as 

 File|Manual Communications 

Selecting “Workstations Settings” from the “Edit” menu would be shown as  

 Edit|Workstation Settings  

Other SSC Products 
Windows Based Software 

• WinSen Sentinel – access control and alarm software.  Operates in conjunction with 
keypads, cardreaders, and alarm system multiplexers to give you maximum access control 
over your facility.  
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• WinSen Site Graphics  - graphically displays your site on your main computer or on a 
separate computer.  Units are displayed in the appropriate color according to their status 
(rented, overlocked, vacant, etc.). 

• WinSen RSCM - “Winsen Remote Site Control Module”, a remote control program which 
communicates with stand-alone keypads at unattended storage facilities.  It works in 
conjunction with WinSen Property Manager or as a stand-alone application. 

• WinSen Home Office - this software package is designed for the owner or management 
company with one or more sites running WinSen Property Manager.  It allows you to 
automatically generate reports at your sites, then transfer them to the home office via E-Mail, 
modem, or fax.  Unless they are faxed, the transferred reports can then be viewed on the 
computer screen, printed, and archived for later printing.  

• Financial Interface – The WinSen QuickBooks Interface is a system that allows the operator 
of a facility running WinSen Property Manager or Electronic Manager to transfer bank 
deposit information from WinSen to QuickBooks (Version 5.0 or later).  The configuration 
program gives the operator great flexibility in specifying how information is transferred 
between the two programs. 

DOS Based Software 
• Property Manager II - the DOS version of our Property Management program.   

• Electronic Manager - multiple site version of Property Manager, this program allows you to 
track multiple facilities on the same computer and within the same software package. 

• Home Office Package - this software package is designed for the owner or management 
company with one or more sites running Property Manager II.  It allows you to automatically 
dial your sites and download reports via modem for viewing, printing, and archiving.  

• Site Graphics Display - graphically displays your site on your main computer or on a 
separate computer.  Units are displayed in the appropriate color according to their status 
(rented, overlocked, vacant, etc.). 

• RSCM - “Remote Site Control Module”, a remote control program which communicates 
with stand-alone keypads at unattended storage facilities.  It works in conjunction with 
Property Manager or as a stand-alone application. 

• Property Sentinel III - access control/alarm system software.  This program controls the 
access system through your computer’s serial port.  It can be used in conjunction with 
Property Manager or as a stand-alone program. 

• SBACK - this program is used to backup the Property Sentinel II, a stand-alone, 
microprocessor based access control/alarm system.  SBACK will save the information to your 
computer hard drive. 

Access Control and Alarm Systems 
SSC also manufactures access control and alarm system products.  Among them are: 

• Property Sentinel II - a stand-alone microprocessor based access control/alarm system that 
can be interfaced to a variety of property management software systems. 

• Keypads - used to control access to a gate or door, these are available with rubber or metal 
keys. 
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• Cardreaders - also used for access control, these allow your tenant to enter or exit with a 
cardkey that is laid against the cardreader briefly.  These are very convenient for your tenants. 

• Alarm system components - door switches, multiplexer circuit cards, and related items.  
When you have an alarm system it gives your tenants extra peace of mind and can command 
higher rental rates. 

Modes of Operation 
The program has two modes of operation with respect to communicating changes to your unattended 
facilities: 

1. Automatic Communications - as explained above, when the program is operating in this mode, 
it will dial all configured remote facilities and update the keypads with the day’s activity.  It can 
be initiated by the manager by selecting “Start Automatic Communications” from the File menu, 
or automatically at a pre-configured time each day.  For example, if it is a long distance phone 
call to your remote site, you could have the program perform the update after 5 P.M. when phone 
rates are lower.  The program also has the ability to update the keypads “real-time”: e.g., as soon 
as a transaction occurs in Winsen Property Manager that affects the remote keypad(s), it will 
initiate Automatic Communications and transmit the changes to them.  

2. Manual Communications – In this mode, you update the remote keypad(s) manually.  Moveins, 
moveouts, lockouts, readmits, etc., are all performed using the “Manual Communications” option 
under the File menu.  The “Manual Communications” options are explained in detail in “Manual 
Communications” on page 18. 

The WinSen RSCM Database 
WinSen RSCM maintains a database of the information in the remote keypads on your computer’s 
hard drive, in a file named “RSCM.MDB”.  During the automatic communications process, this 
information is updated as changes are transmitted to the remote keypads.  Thus, you always have a 
current backup copy of the remote keypad database.  This makes it unnecessary to backup the remote 
keypads regularly, although you can do so if desired. 

Installation from CD-ROM  
1. Before installing, we recommend that you close all open applications. 

2. If you are planning to make any changes to the standard letters or the reports included with 
the system, install Crystal Reports according to the instructions supplied with the Crystal 
Reports CD-ROM or diskettes.  If you do not plan on making changes to the standard letters 
and/or reports, it is unnecessary to install Crystal Reports. 

3. Insert the WinSen CD into your CD-ROM drive.  After a few seconds, the “WinSen 
Installation System” will run automatically.  Select the “Install WinSen” option to run the 
WinSen Setup program.  

4. If for some reason the WinSen Installation System does not run automatically, point to the 
Start button to display the Start Menu.  You can also bring up the Start Menu by pressing 
<Ctrl+Esc>.  From the Start Menu, choose “Run”, then type D:\Setup and click OK.  This 
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assumes D: is your CD-ROM drive, if this is not the case use the appropriate drive letter. The 
WinSen setup program will run.   

5. If you have previously installed Winsen, an introductory message will be displayed, 
recommending that you backup your data before installing an update.  If you are installing an 
update and have not backed up your database, we strongly suggest that you do so before 
continuing.  Click OK to display the Welcome dialog.  After reading the messages in the 
Welcome dialog, click Next.  

6. The Software License Agreement dialog will be displayed.  After reading the Software 
License Agreement, click Next to continue.  You must click Next, indicating your acceptance 
of the agreement, to install WinSen.   

7. The Choose Destination Location dialog will be displayed.  This allows you to select the 
installation location for WinSen.  If you have previously installed WinSen the previous 
installation folder will be selected.  The default location is C:\Winsen.  Click Next to 
continue. 

8. The Select Components dialog will be displayed.  In this screen you can select or deselect 
which WinSen components to install.  A default set of components will already be selected.  
The “Standard Reports and Letters” and “Standard Word Templates” options install the latest 
reports and Word templates.  If you have customized reports or letters, note that the 
installation program will make backup copies of the reports (in a folder called RPTBKUP) 
and Word letter templates (in a folder called DOTBKUP) before installing the standard ones.  
These folders will be created under the Winsen installation folder.  This allows you to restore 
any custom reports and/or letters after the installation is completed.  Ensure that “Remote Site 
Control Module” is selected, then click Next to continue.  

9. The Select Program Manager Group dialog will be displayed.  This allows you to specify 
the name of the folder under the Start Menu where you wish the WinSen program shortcut 
icons to be created.  The default name is WinSen.  Click Next to continue. 

10. The Start Installation dialog will be displayed.  Click Next to install the selected WinSen 
components.  

11. The Installation Complete dialog will be displayed.  Click the Readme button if you wish to 
read the latest WinSen release notes.  When you are ready, click Finish.  

12. You will now have a new program group called “WinSen” (this may be different if you chose 
a custom installation).  Within this program group will be icons for the WinSen programs you 
installed.  

13. You must now license your WinSen program.  Please contact your Sentinel Sales Team 
member or our Technical Support Department at 1 800 456 9955. 

This concludes the CD-ROM program installation. 

Running the Program 
To run WinSen RSCM: 

1. If you are running WinSen Property Manager, select “WinSen RSCM” from the “Special” menu 
of WinSen Property Manager (Special|WinSen RSCM).  

2. Point to the Start button, then Programs, then WinSen, then WinSen RSCM.  
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If you are running the trial version of WinSen RSCM for the first time, it will display an introductory 
message saying that the trial period is 30 days.  The program will run for 30 days from the first time it 
is run.  To obtain a license key to enable the full version, please refer to the following section, 
“Licensing”. 

The WinSen RSCM main menu will be displayed:  

 

Licensing  
The WinSen licensing program is used to enter the user registration information, and change the 
WinSen licensing options.  The WinSen CD-ROM contains all WinSen programs.  You can install 
any of the programs on the CD, but if a particular program has not been purchased, it becomes a trial 
version which will run for 30 days from the date of installation.  The WinSen Licensing program 
allows you to enter a software key which changes purchased software from trial to fully enabled 
versions.  

There are two ways to run the WinSen Licensing program.  You can either select the Licensing option 
from the Help menu, or point to the Start button to display the Start Menu, select the “Run” option, 
type in c:\winsen\license, then click OK.  The following form will be displayed:  
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If you do not already have a license key, contact Sentinel Systems (SSC).  You will be asked for the 
Computer ID number displayed by the Licensing form.  Based on the Computer ID and the 
software you have purchased, SSC will create a license key consisting of a sequence of characters you 
will enter in the License Key field.  The key can be received from SSC via telephone, fax, mail, or 
electronic mail.  When you receive it, write it down in a safe place in case you ever have to reinstall 
the software.  Note that the key is good only for the original computer; if you need to transfer the 
WinSen software to a new computer, contact SSC for a new license key.  

The Registered Programs, Options, Unit Limit, and Net Licenses fields show the programs and 
options that have been purchased, the number of units allowed in WinSen Property Manager, and the 
number of network licenses purchased.  These fields are for display only and cannot be directly 
changed.  

The Trigger Codes fields are used for special situations.  For example, if you are running WinSen on 
a trial basis, and the trial period has expired, and you would like another 30 day trial period, SSC can 
issue a trigger code to accomplish this.  In cases like this, contact SSC and give the technician the 
Code Entry Number and the Computer ID.  You will then be given one or two trigger codes.   

In the Name and Company fields, enter the name of the person who owns the software, and the 
company name.  The Serial Number field cannot be edited; it will be set appropriately by the license 
key.  Enter the license key or trigger code(s) received from SSC in the appropriate field, then click 
OK.  All appropriate software options will be enabled according to the entered license key or trigger 
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code(s), and the Licensing form will close.  The changes will not take effect until you close and 
reopen WinSen.  

Organization of the Menus 
Following is the organization of the menus and a brief explanation of each menu selection.  The 
various options will be explained in detail later on in this manual. 

File 

 

Start Automatic Communications: initiates the automatic communications process for all active 
sites.  The program will transmit all transactions that have occurred since the last time this function 
was invoked to the remote keypads.  The function is normally invoked after 1 or more transactions 
affecting the remote facility have occurred in WinSen Property Manager, e.g., movein, moveout, 
lockout, readmit, change password.  These transactions are stored on the computer hard drive as they 
occur, but the remote keypads are not updated until the Automatic Communications function is 
invoked.  

Manual Communications: displays the manual communications form.  This form is used to update 
the remote keypads with tenant activity when you are not running WinSen Property Manager.  It is 
also used to configure the time zones, relay timeouts, passcodes, and keypad types at the remote 
facility.  The Manual Communications operations are explained in detail in “Manual 
Communications” starting on page 18. 

Delete Communications History File: deletes the file containing the communications history (the 
filename is COMMLOG.TXT).  This file details the events that occur while the program is 
performing remote communications.  

Exit:  closes WinSen RSCM.  

Edit 

 

Workstation Settings: used to define the COM port where the local modem is connected, the 
communications parameters, the report printer, and the “start time” for unattended automatic 
Communications.  

Configure Remote Sites:  used to create, edit, and delete remote sites.  Use this option to specify the 
remote site name & address, whether it is an active site, phone number, number of keypads, and time 
difference.  

View 
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Reports:  used to view or print reports detailing tenant activity at the remote sites, and lists of the 
users contained in the RSCM database.  

Communications History File: allows you to view or print the log of the events that occur while the 
program is performing remote communications.  

Clear Display:  clears the displayed list of the events that occur while the program is performing 
remote communications.  

Special 
The Special menu contains only one choice: Convert WinSen Property Manager Data.  This option 
will convert the users in the WinSen Property Manager database to the WinSen RSCM database.  It 
would be used if you are initializing the RSCM system and you already have WinSen Property 
Manager on-line, or any other time it may be necessary to convert the database.  After using this 
option, you would then perform a restore keypad operation from the Manual Communications form to 
transmit the users to the remote keypads.  

Help 
This menu allows you to obtain “on-line” help.  You can also press “F1” at any time for context-
sensitive help. 

Context Menu  
The Context Menu shows commonly used options, and is accessed by right clicking on the event 
display or status bar areas of the main program.  

 

Start Automatic Communications: initiates the automatic communications process for all active 
sites.  The program will transmit all transactions that have occurred since the last time this function 
was invoked to the remote keypads.  The function is normally invoked after 1 or more transactions 
affecting the remote facility have occurred in WinSen Property Manager, e.g., movein, moveout, 
lockout, readmit, change password.  These transactions are stored on the computer hard drive as they 
occur, but the remote keypads are not updated until the Automatic Communications function is 
invoked.  

Automatic Keypad Update:  toggles the Automatic Keypad Update option on or off.  When this 
option is on, the program will update the keypads “real-time”: e.g., as soon as a transaction occurs in 
Winsen Property Manager that affects the remote keypad(s), it will initiate Automatic 
Communications and transmit the changes to them.  

View Communications History File: allows you to view or print the log of the events that occur 
while the program is performing remote communications.  

Clear Display:  clears the displayed list of the events that occur while the program is performing 
remote communications.  
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Program Configuration  

Initial Setup  
After installing the remote standalone keypad system as detailed in the “Standalone Keypad” manual, 
and the WinSen RSCM software, it will be necessary to configure the program as explained in the 
following sections.  Be sure the remote keypads are installed, powered up, and addressed properly as 
explained in the Standalone Keypad manual before attempting remote communications.  

Workstation Settings 
The Workstation Settings form is used to configure the modem, modem port, modem initialization 
string, COM parameters, report printer, start time for unattended automatic communications, and 
other options.  Choose Edit|Workstation Settings to display the following form:  
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Modem  
From the drop down list, select the modem that RSCM should use to communicate with the remote 
keypad(s).  All installed modems will be shown; select the proper one from the list.  

The dropdown list will also show the installed COM ports on your PC.  Normally, you should select a 
modem rather than a COM port, but in certain cases it may be necessary to select the COM port to 
which the modem is attached.  

If a modem is selected, the program will use TAPI (the Windows Telephony Application 
Programmer’s Interface) to communicate with the modem.  Windows will take care of all modem 
initialization, port parameters, and communications. In this case, the following two options are 
disabled because they are handled by Windows. 

If a COM port is selected, the program will communicate directly to the modem via the selected 
COM port. In this case, you will also need to configure the following two options.  

Modem Init 
If you are using a COM port rather than a modem (see the above discussion), this field is used to 
specify the initialization string for the modem.  The program will send this string to the local modem 
to initialize it before it begins a remote communications session.  The default initialization string is:  

 ATZ^M ATX4^M 

In the above initialization string, the “^M” represents a carriage return, and separates modem 
command strings.  Thus, the above string will send 2 commands to the modem when WinSen RSCM 
initializes it: the ATZ command resets the modem to its default setup, and the ATX4 command tells 
the modem to return “verbose result codes” when connecting.  

Parameters 
If you are using a COM port rather than a modem (see the above discussion), enter the 
communication parameters.  The recommended setting is  

 2400,N,8,1 

This means 2400 baud, no parity, 8 data bits, and 1 stop bit.   

Note that the program will automatically fill this value in the first time it is run, therefore you will not 
normally need to change it.  

Connect Timeout  
This is the amount of time the program should wait for a connection when dialing remote sites.  The 
default is 45 seconds, which should work for most systems.  Modify it as necessary.  The maximum 
setting is 999 seconds.  

Report Printer  
The drop down list will show a list of all printers within your Windows installation.  Choose the 
printer you wish to use to print reports.  

Auto Keypad Update / Auto Comm Delay   
When the Auto Keypad Update option is enabled, the program will update the keypads “real-time”: 
e.g., as soon as a transaction occurs in Winsen Property Manager that affects the remote keypad(s), it 
will initiate Automatic Communications and transmit the changes to them.  If this option is selected, 
you can also configure the Auto Comm Delay: the number of seconds after a transaction has 
occurred in Winsen Property Manager to wait before beginning the Automatic Communications 
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process.  The default for this setting is 2 seconds and should normally not need to be changed.  The 
Auto Comm Delay helps to ensure that there will be no file contention for the update??.txt files that 
Winsen Property Manager uses to communicate with RSCM.  

Start Time  
Enter the time when you wish unattended automatic communications to occur.  Enter the start time in 
military format.  For example, to begin “Automatic Communications” at 9:00 in the evening, enter 
“21:00” for the Start Time.  For 2:00 in the morning, the entry would be “02:00”. 

At any time when you are running WinSen RSCM, the program continually checks the current time 
against the Start Time.  When they match, the program will go into “Automatic Communications” 
and proceed with dialing the sites.  

Configure Remote Sites  
The Configure Remote Sites form is used to add, edit, and delete remote facilities in the RSCM 
database.  This form allows you to enter communications information for each site that is using the 
standalone keypads.  Choose Edit|Configure Remote Sites to display the following form:  

 

Data Control Bar: this portion of the form allows you to change the record number currently being 
edited.  Use your mouse to click the buttons and perform the following actions:  
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Moves to the first record.

Moves to the previous record.

Moves to the next record.

Moves to the last record.

 

Adding a Site:  when configuring the software for the first time, there will be no remote site records 
in the database, and you will need to add one by clicking the Add button.  After doing this, the Add 
button will change to an Update button, which you will click to save your changes after you have 
entered all relevant information about this remote site.  

Deleting a Site:  to delete a site, use the “Data Control Bar” at the bottom left of the form to navigate 
to the proper site record.  Then click the Delete button.  The program will verify that you really want 
to delete this site record.  Choose Yes to permanently delete the site.   

Note:  If you wish to retain the tenant, keypad, and event data regarding the site, it is not 
recommended to delete the site record.  Instead, uncheck the “Active Site” checkbox.  This way, you 
can still print reports on the tenant and activity data stored in the database for that site, but it will not 
be included in the communications routines.  
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Site Information  
Site ID:  this value will be assigned automatically by the program as soon as you save the new record, 
and cannot be edited.  It is used to link the customer records to the site and keypad records.  

Site Name & Address: fill in the name of the remote site.  If desired, fill in the site address fields as 
well.  WinSen RSCM does not currently use the address fields.  

Active Site: this checkbox designates that the site is active.  If checked, the site will be included in 
the remote communication routines.  If not checked, the site will not be included in the remote 
communications routines but will be included in the report menu.  One situation where this would be 
useful if you have sold the site but do not wish to delete the information pertaining to the site.  
Another scenario might be where you do not wish to include the site in Remote Communications 
temporarily due to communications difficulties, power failure, etc.  

Site Number: the site number field corresponds to the site number for units in the WinSen Property 
Manager or Electronic Manager database.  If you have WinSen Property Manager (single site 
software), set this field to “0”.  Then transactions involving all units in WinSen Property Manager 
will be transmitted to this site during the Automatic Communications process. 

If you have WinSen Electronic Manager (the multiple site version), set this field to the appropriate 
site number.  For example, if site #2 in WinSen Electronic manager is a remote standalone keypad 
site, set the Site Number to “2” in WinSen RSCM.  Then transactions involving units in WinSen 
Electronic Manager carrying a prefix of “02” will be transmitted to this site during the Automatic 
Communications process.  

Communications Information 
Phone Number: enter the phone number of the modem line at the remote facility.  WinSen RSCM 
also supports having keypads connected directly to the computer through a COM port instead of 
communicating with them via modem.  If this is the case, enter the COM port in the phone number 
field.  For example, enter COM1 if your remote keypads are connected directly to COM1 on the PC.  

Model: currently, this field only has one choice, “Keypad”.  In future versions this field will be used 
for configuring what kind of device is in use at the remote site.  

Keypad Quantity: enter the number of keypads at the remote site.  It is important that the correct 
number is entered. 

Time Difference: enter the time difference in hours between the home office and the remote site.  For 
example, if the remote site is one hour ahead of the main office, enter 1.  If the remote site is one hour 
behind the main office, enter –1.  It is important that this field be set properly because the WinSen 
RSCM software will set the keypad date & time to the computer date & time every time it performs 
the Automatic Communications function.  

Completing the Initial Setup 
After installing the Standalone Keypad hardware, addressing the keypads, establishing the 
Workstation Settings, and configuring the remote site(s), complete the following to finish 
implementing your Remote Standalone Keypad system: 

1. For each keypad, setup the time zones, relay timeouts, keypad type, and programming mode 
security code.  Procedures for doing this are found in “Keypad Operations” on page 22. 

2. Install the user ID’s.  If you have WinSen Property Manager/Electronic Manager, first establish 
that database, then run the conversion described in “Appendix A – Converting a WinSen Property 
Manager Database” on page 29.  Otherwise, install the User ID’s using Manual Communications 
as described in “Tenant Operations” on page 19. 
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3. Perform a restore operation as described in “Backing up/Restoring Keypads” on page 23. 

Setting up WinSen Property Manager to work with RSCM 
In order for WinSen RSCM and WinSen Property Manager/Electronic Manager to work together 
properly, there are two items in WinSen Property Manager/Electronic Manager to verify: 

1. In Maintenance|Site Setup|Site Information, be sure the Gate Interface is set to “WinSen 
RSCM” or “WinSen RSCM (passcode only)”.   

2. In Maintenance|Add/Remove Units, make sure the “Interface” number for each unit matches 
the unit number.   
 
If the “WinSen RSCM (passcode only)” gate interface is selected in Winsen Property Manager, 
RSCM will use only the passcode for the 9 digit User ID to be sent to the remote keypads. Thus, 
if a unit that has just been moved in has been assigned a passcode of “123456”, the User ID that 
WinSen RSCM will send to the remote keypads will be “000123456”.  Note that the customer 
does not have to enter the leading 0 in this example User ID at the keypad; entering “123456” 
will open the gate.  
 
If the “WinSen RSCM” gate interface is selected in Winsen Property Manager, the Interface 
number in Add/Remove Units is very important because the 9 digit User ID that is created by 
WinSen Property Manager/Electronic Manager for WinSen RSCM to transmit to the remote 
keypads consists of two parts.  The first part of the User ID is the Interface number; the second 
part is the passcode that is assigned during movein.  Thus, if a unit that has just been moved in 
has an Interface number of “1001” and the passcode for that unit is “1234”, the User ID that 
WinSen RSCM will send to the remote keypads will be “010011234”.  Note that the customer 
does not have to enter the leading 0 in this example User ID at the keypad; entering “10011234” 
will open the gate.  
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Remote Communications 

Automatic Communications 
The Automatic Communications function will transmit all transactions that have occurred since the 
last time this function was invoked to the remote keypads.  The function is normally invoked after 
one or more transactions affecting the remote facility have occurred in WinSen Property 
Manager/Electronic Manager, e.g., movein, moveout, lockout, readmit, or change passcode.  These 
transactions are stored on the computer hard drive as they occur, but the remote keypads are not 
updated until the Automatic Communications function is invoked.  

If the “Auto Keypad Update” option is on (see “Auto Keypad Update / Auto Comm Delay” on page 
12), the program will perform the Automatic Communications function as soon as any transaction 
occurs in Winsen Property Manager that affects the remote keypad(s).  In this case, there is no need to 
invoke the Automatic Communications function manually.  

Initiating Automatic Communications  
If you are not using the “Auto Keypad Update” option, there are 3 ways to invoke the Automatic 
Communications function: 

1. Select it from the File menu of WinSen RSCM.   

2. Select it from the Context Menu that will appear by right clicking on the event display area or the 
status bar of the RSCM Main Menu.  

3. Set the “Start Time” in Edit|Workstation Settings to the time when you wish the program to 
start the Automatic Communications.  Then when that time arrives, WinSen RSCM will perform 
the Automatic Communications function for all active sites.  Note that WinSen RSCM must be 
running for this to work.  The program will continue to do this each day when the start time 
arrives.  

Operations Performed During Automatic Communications  
When the WinSen RSCM software performs the Automatic Communications function, the following 
operations are done for each active remote site:  

1. All transactions that occurred since the last time the Automatic Communications function was 
invoked are transmitted to the remote keypads.  As it does this, the WinSen RSCM database is 
updated with these changes, ensuring that the database is always current.  

2. The tenant activity data (entrances, exits, bad passcode, etc) contained in the remote keypads is 
transferred to the WinSen RSCM database for reporting purposes. 
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3. The date & time in the remote keypads will be set to the date & time of the home office 
computer.  If the remote site is in a different time zone, the program will adjust for this using the 
“Time Difference” field in Edit|Configure Sites.  

Manual Communications 
The Manual Communications form allows you to perform a variety of operations on your remote 
sites.  If you do not have WinSen Property Manager/Electronic Manager, it is used to update tenant 
data.  It is also used to configure your keypad data such as the time zones (gate hours), relay timeouts, 
security code for programming mode, and keypad types.  It can also be used to open a gate, set the 
date & time, transfer tenant activity events to the computer, set the keypad defaults, and backup or 
restore the data in the remote keypads. 

Select “Manual Communications” from the File Menu to display the following form:  

 

Note how the title bar of the Manual Communications form shows the currently selected site name.  If 
the currently selected tab is “Tenant Operations”, this will be followed by the currently selected User 
ID.  If the currently selected tab is “Keypad Operations”, the site name is followed by the number of 
users in the current site.  

The upper portion of the Manual Communications form has the following options: 

Site: from the drop-down list, select the site you wish to work with.  The first site in your database 
will be displayed by default.  
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Keypad: this listbox allows you to select which keypad to perform operations on.  Next to it is a 
checkbox labeled, “Include All Keypads”.  By default, this box will be checked.  When checked, 
operations that are performed will affect all of the keypads (except for the open gate command).  If 
the Include All Keypads checkbox is not checked, operations will affect only the keypad that is 
currently selected.  As mentioned, the open gate command always affects only the currently selected 
keypad.  

Open Gate: allows you to open a gate at the remote facility.  The gate that is wired to the currently 
selected keypad will be opened by clicking this button.  

Help: access the on-line help file.  

Close: closes the Manual Communications form.  If you are on-line, this will also hang up the 
modem.  

The lower portion of the Manual Communications form contains two tabs: Tenant Operations, and 
Keypad Operations, explained below.  Click the desired tab with your mouse to switch to it.  

Tenant Operations 

 
Tenant Operations allows you to add, delete, edit, lockout, and readmit tenants in the remote keypads.  
Tenant data is displayed in a table view format, with User ID, Time Zone, and Locked Out columns.  
Buttons and checkboxes are provided which allow you to perform all tenant operations described 
below.  

Communications history display: after changing any data on the Manual Communications form, the 
program will update the remote keypads immediately, unless you have checked the Work Offline 
option (explained on page 21).  Anytime RSCM is communicating with the remote keypad(s), the 
events will be shown in the Communications History display on the main menu: 
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Events are also displayed during Automatic Communications. 

While communications are occurring, you can click the Cancel button to cancel them if desired.  

Editing Tenant Data 
To edit tenant data, click on the row with the User ID you wish to edit.  To edit the information, 
merely start typing.  When finished editing a particular cell, move to another row to complete the 
change.  You can move to another row using your mouse, the <Tab> key, the <Enter> key, or the 
arrow keys. 

User ID:  The User ID the customer will enter at the remote keypads to gain access to the facility.  
Up to 9 digits are supported.  When entering User ID’s, we suggest that the last four characters 
correspond to the passcode for the unit, and the first 5 (not all 5 need be used) correspond to the unit 
number.  For example, if a customer in unit 1023 has a passcode of 9999, use 10239999 for the User 
ID number.  Another example: a customer in unit 1 has a passcode of 4455; assign this customer a 
User ID of 14455. 

Any user ID number can be used but if the above scheme is followed, it will make it much easier to 
determine the unit number involved when reviewing tenant activity reports.  

Time Zone:  SSC Standalone keypads support 4 time zones, 0 to 3.  Enter the time zone number for 
the highlighted User ID.  The actual gate hours are defined on the Keypad Operations tab, explained 
in “Setting up the Time Zone Definitions” on page 22.  

Adding a User ID 
Click the Add button to add a new user ID to the database.  When you do this, the program will add a 
new user ID which is incremented from the last user ID displayed.  The new user ID is incremented in 
two parts: the first five digits, corresponding to the unit number, are incremented by 1, and the last 
four digits, corresponding to the passcode, are incremented by 1.  Thus, if the last user ID displayed is 
10011234, clicking the add button will cause RSCM to add a new user ID of 10021235. 

After clicking the add button, the new user ID is not added to the database until you move to a 
different row.  This allows you to modify the new user ID as required before it is added to the 
database and sent to the keypad(s).   
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Edit the newly created User ID to match the one that you want to add, then move to another row or 
click the Add button if you want to add another user ID.  The new User ID will be added to the 
WinSen RSCM database and the remote keypad(s).  

Auto Adding:  if this check box is selected, the program automatically adds a new user whenever you 
are on the last row in the table, and you press the down arrow key.  You then edit the new user ID to 
match the desired entry as explained above, and press the down arrow key again to update the record 
and add another new user ID.  This allows you to add User ID numbers very quickly. 

Deleting a User ID 
To delete a User ID, first highlight the desired record, then click the Delete button.  If the Verify 
Deletes checkbox is checked, RSCM will verify that you wish to delete the User ID; select Yes to 
delete the User ID.  To delete User ID’s without verification, uncheck the Verify Deletes option.  

After deleting the selected User ID, the keypads will be updated unless you have checked the Work 
Offline option (explained on page 21). 

Locking Out/Readmitting a User ID 
To lockout or readmit a User ID, first highlight the desired record, then click the Lockout or 
Readmit button. You can also check/uncheck the locked out checkbox, and the user ID will be 
locked out/readmitted as soon as you move to a different row.  

Locking out/readmitting multiple User ID’s:  WinSen RSCM will allow you to select more than 
one User ID at a time to lockout or readmit.  To select multiple User ID’s, hold the Ctrl or Shift keys 
down while selecting rows with the mouse. The right hand status bar at the bottom of the form will 
indicate how many record(s) are selected.  After selecting all desired records, click the lockout or 
readmit button to lockout/readmit all selected User ID’s.  If the Verify Multiple option is checked, 
WinSen RSCM will verify that you want to lockout/readmit the group of User ID’s.  Note that when 
you have selected multiple records, only the selected units will be included in the operation.  The 
current record will only be included if it is selected.  

Deselect Button: if you have multiple records selected, this button will deselect all of them.  Note 
that it is disabled if there are not multiple selections.  

Work Offline  
Check this box to “work offline”.  In this mode, the changes you make are not transmitted to the 
keypads as you make them; instead they are saved to the hard drive.  After making your changes, 
there are two ways to update the remote keypads: 

1. Initiate Automatic Communications by selecting it from the File Menu.  If you have changed 
only tenant information, this will be the fastest, most efficient method, since only the changes that 
were made will be transmitted, not the entire database.  

2. Perform a restore operation on the remote keypads as explained in the following section.  

Note:  Be sure to initiate the Automatic Communications option after you are finished working in 
offline mode.  The keypads will not be updated until you perform Automatic Communications.  Until 
you do, the keypad database will be “out of sync” with the WinSen RSCM database.  
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Keypad Operations 

 

The Keypad Operations tab on the Manual Communications form is used to setup the time zone 
definitions, keypad type, relay timeouts, and security code.  It is also used to set the keypad defaults, 
backup and restore the remote keypads, set the date & time, and transfer tenant activity from the 
keypads to the WinSen RSCM database.  

The information on this tab applies to the currently selected keypad.  If you have more than one, setup 
all options for the first keypad, select the next keypad from the keypad selection list, and repeat the 
process for each keypad.  

After you have entered all required information, click the Restore button to transmit the data to the 
remote keypads.  Be sure the “All Keypads” checkbox is selected so that all keypads are updated.  
Restoring is explained in detail below.  

Setting up the Time Zone Definitions  
The time zone table is used to define your time zones.  Four time zones are supported: 0 to 3.  Start 
and Stop gate hours for each time zone are entered for each day of the week.  Enter the times in 
military format.  To convert to military format, add 12 to PM times.  For example, 8:00 P.M. is 20:00 
in military format.  No conversion is necessary for AM times.  

When entering a time in the time zone table, you do not have to enter trailing zeros.  For example, if 
the time to be entered is 20:00 (8:00 PM), you can just type in 20 and go to the next time, and the 
program will automatically format it to 20:00.  
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In the above example, time zone 0 is normal access, with gate hours from 7:00 AM to 8:00 PM.  
Tenants who are assigned this time zone can only access the gate during those hours.  The other three 
time zones allow 24 hour access.  

Note:  If the gate hours are restricted for any time zone, you may want to allow 24 hour access for all 
time zones in the Exit keypad.  This avoids locking tenants in the facility if they stay beyond their 
gate hours. 

Keypad Type, Relay Timeouts, Security Code  
Keypad Type: choose the correct keypad type for the currently selected keypad: Entrance, or Exit.  
It is important that the keypad type be set properly or the tenant activity will not be reported correctly.  
For example if they are reversed, the activity log will show tenants exiting when they are actually 
entering, and vice versa.  

Relay 0 and Relay 1 Timeouts: these fields are the number of seconds the relay stays closed when a 
valid access code is entered, or the open gate command is performed.  Normally, only relay 0 is used.  
The timeout value is normally set to 1 second, although you may need to change that depending on 
the requirements of your gate operator.  Valid relay timeout values are 0 to 30 seconds. 

Security Code: this is the passcode required to go into “Programming Mode” at the keypad itself.  
Valid security codes range from 0 to 9999.  It is highly recommended that you set this to a 4 digit 
value, to prevent your tenants from accidentally getting into “Programming Mode”.  

Set Defaults 
Clicking this button will cause WinSen RSCM to “set the defaults” on the keypads.  This operation 
clears out all user ID numbers and resets all 4 time zones to 24 hour access.  It is normally only used 
in unusual circumstances, e.g., if you are installing a brand new keypad and want to initialize it.  After 
performing this operation, you should next do a restore keypad operation to restore the users, time 
zones, relay timeouts, and security code. 

When you click this button, WinSen RSCM will verify that you really want to set the keypad 
defaults.  Choose Yes to set the defaults. 

Backing up/Restoring Keypads 
Transmit: the three checkboxes in this area allow you to specify what data is to be sent to or from the 
keypads when you perform a backup or a restore.  You can send only the information that is 
necessary by checking or unchecking the boxes as required.  For example, if you have changed your 
time zone definitions, the keypads will not be updated until you perform a restore.  Since the time 
zones are the only data that has changed, deselect “User ID’s” and “Timeouts, Security Code, Type”, 
then perform the Restore operation.  Only the time zones will be transmitted.  

Backup: the Backup button will transfer the database in the keypads to the computer hard drive to be 
stored in the WinSen RSCM database.  Only the data that is selected in the Transmit option will be 
received.  Note that it is normally unnecessary to backup the keypads, since WinSen RSCM maintains 
a database of all information in them which is updated whenever changes are made.  

Note:  When a backup of the keypads is done, the data contained in the database is updated, not  
overwritten.  This means that in the unlikely event that the keypad data is corrupted, the data in the 
database will be preserved.  If the data in the keypads is corrupted for some reason, you can correct 
this by setting the defaults, then doing a full restore.  
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Restore: the Restore button will transfer the data from the WinSen RSCM database to the keypads.  
Only the data that is selected in the Transmit option will be sent.  

Set Time 
Click this button to set the date & time in the keypads to the date & time of the computer.  Note that 
this is done automatically during the Automatic Communications function.  

Dump Events 
Clicking the Dump Events button will transfer tenant activity (entrances, exits, bad passcodes, etc.) 
from the keypads to the WinSen RSCM database.  Note that this is done automatically during the 
Automatic Communications function.  You can then print reports on this activity as necessary.  For 
details on how to view/print reports, see “Using the Report Menu” on page 27.  

Communications History 
Whenever remote communications occur, WinSen RSCM logs the communications activity to a file 
for later viewing.  If there are problems encountered during remote communications, reviewing this 
file can be helpful to determine the cause. 

Viewing Communications History  
To view the Communications History file, select View|Communications History File.  The file will be 
opened in either Notepad or Wordpad, depending on your operating system and the size of the file: 
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Deleting the Communications History File  
After a time, the communications history file will become quite large, and should be deleted.  To do 
this, select File|Delete Communications History File.  WinSen RSCM will verify that you want to 
delete it.  Choose Yes to delete it.  
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Reports 

Using the Report Menu  
The WinSen RSCM report menu allows you to view and/or print reports detailing all data contained 
in the WinSen database, and reports showing the tenant activity that has occurred for a given time 
period.  To access the report menu, select View|Reports.  The following form will be displayed:  

 

There are currently two reports available: the Activity Report, and the Keypad Report.  

Activity Report  
From the Site drop-down list, select the site for which you wish to print the activity report.  If you 
wish to print activity for a specific User ID, enter it in the User ID text box.  Otherwise, all user ID’s 
with activity in the date range will be printed.  Then enter the date range to be included on the report.  
By default, the date range will include only today’s activity.  

Keypad Report 
From the Site drop-down list, select the site for which you wish to print the keypad report. 

The Keypad Report details all data in the WinSen RSCM database relating to the keypads: the User 
ID’s, time zones, relay timeouts, and security code.  When you select the Keypad Report, the report 
form will change to allow you to select which keypad to print the report for: 
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By default, all keypads are selected, and you will get a report for all of them.  If you want to print a 
report for only one of them, click the desired keypad; all other keypads will then be deselected.  

Output Options - Select one of the three output options: 

1. Printer:  The selected report will be sent to the printer.  This will normally be the report 
printer that is defined in WinSen Property Manager.  If you wish to change the printer, 
choose the Printer button, and you will be allowed to select which printer (if you have more 
than one) within your Windows installation you want the report to go to. 

2. Window:  The selected report will be output to a window for viewing.  This is the default 
selection. 

3. File: The selected report will be printed to a disk file in a comma delimited format, suitable 
for import into a spreadsheet program.  The files will be generated in the directory where the 
program is installed and will have the following file names:  

• Activity Report:  RSEVENT.CSV 

• Keypad Report:  RSKP.CSV 
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Appendices 

Appendix A – Converting a WinSen Property Manager 
Database 

WinSen RSCM has the ability to convert a WinSen Property Manager or WinSen Electronic Manager 
database to a WinSen RSCM database.  This would be useful when you are installing RSCM and the 
remote keypads for the first time, or any time you need to convert the data in WinSen Property 
Manager/Electronic Manager.   

To convert the WinSen Property Manager/Electronic Manager database, select Special|Convert 
WinSen Property Manager Data.  The following form will be displayed: 

 

Delete existing User ID’s: click this checkbox to delete any existing user ID’s already in the WinSen 
RSCM database before the conversion is done.  You would want to do this if there are extra User ID’s 
in the RSCM database that you wish to delete.  If this check box is not selected, any User ID’s in the 
RSCM database that do not correspond to units in the WinSen Property Manager/Electronic Manager 
database will still be there after the conversion.  

Click the Convert button to perform the conversion.  When the process is complete, perform a 
Restore operation in Manual Communications to transfer the data to the remote keypads.  
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Appendix B – Converting a DOS RSCM Database 
WinSen RSCM has the ability to convert the DOS version of RSCM to a WinSen RSCM database.  
This would be useful when you are upgrading from our DOS software to WinSen RSCM, and you 
wish to preserve the tenant activity stored in the DOS RSCM database, or if you do not have our 
Property Management software.  

If you are converting from our DOS Property Manager or Electronic Manager to WinSen, and you do 
not need to preserve the tenant activity contained in the DOS RSCM database, this step is 
unnecessary.  Instead, you would run the PM2 to WinSen Property Manager/Electronic Manager 
conversion, and then the WinSen Property Manager/Electronic Manager to WinSen RSCM 
conversion described in “Appendix A – Converting a WinSen Property Manager Database”.  

To convert a DOS RSCM database:  

1. If WinSen RSCM is running, close it.  Note that any existing WinSen RSCM data will be 
overwritten by performing the conversion.  

2. Select the “Run” option from the Start Menu.  

3. You will be asked for the “Command Line”.  Type in C:\WinSen\RCONVERT and click OK.  
The conversion program will run:  

 

By default, the program will use the C:\PM2 directory for the source files, and the C:\WINSEN 
directory for the destination.  You can use the Change Directory buttons to display the standard 
Windows file selection dialog box and change these if necessary. 

Click Continue to perform the conversion.  When the conversion is finished, all data in the DOS 
RSCM database (communications information, site configuration, keypad information, User ID’s, and 
the last 1 year of tenant activity) will have been transferred to the WinSen RSCM database.  
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Appendix C – Initializing the Remote Modem 
The recommended modem for the Standalone Keypad application is the US Robotics Sportster 33.6 
External Modem, model #839.   

This section details how to setup the US Robotics model 839 modem for use at the remote facility 
with the remote Standalone Keypads.  It does NOT apply to the modem in service at the home office.  
Almost any modem can be used at the home office end.  

Before the modem can be placed into service at a remote facility, the below procedure must be 
followed.  If you purchased the modem from Sentinel Systems, this procedure was done before the 
modem was shipped, therefore you do not need to repeat it.  

1. With power off, set the dip switches on the back of the modem according to the following table: 
   

US Robotics Sportster Modem Dip Switch Settings 

SW-1 SW-2 SW-3 SW-4 SW-5 SW-6 SW-7 SW-8 

Down 
(On) 

DTR 
Always 
Asserted  

Up 
(Off) 

Verbal 
Result 
Codes 

Down 
(On) 

Display 
Result 
Codes  

Up 
(Off) 

Echo 
Offline 

Commands 

Up 
(Off) 

Auto 
Answer 

on 1 Ring 

Up 
(Off) 

Normal 
CD 

Operations 

Up 
(Off) 

Load 
NVRAM 
Defaults 

Down 
(On) 

AT 
Commands 

Enabled 

2. Connect the modem to a computer and run a telecommunications program, for example “Telix”, 
“Procomm”, “BitCom”, “Terminal”, “Hyperterminal”, etc.  Go into “terminal mode”.  Ensure that 
the communications parameters are set at 2400 baud, No parity, 8 data bits, and 1 stop bit 
(2400,N,8,1).  This is very important. 

3. Issue the following 2 command strings to the modem: 
AT &F0 

AT S0=1 &N3 &D0 &W0 &W1 

The purpose of the various commands are as follows: 

AT the “attention” command, tells the modem that commands follow. 

&F0 sets the modem to the factory default configuration. 

S0=1 sets the modem to answer the line after 1 ring (dip switch 5 should be off). 

&N3 sets the baud rate to 2400.  2400 baud is required for communications with the keypad. 

&D0 DTR (Data Terminal Ready) is always asserted. 

&W0 writes above defined configuration to user defined memory area 0. 

&W1 writes above defined configuration to user defined memory area 1. 

After setting the dip switches and issuing the above command strings, the modem should 
automatically load the correct configuration on power-up. 
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